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Introduction to Linux Mint

Linux Mint is a computer operating system designed to work on most modern systems, including
typical x86 and x64 PCs.

Linux Mint can be thought of as filling the same role as Microsoft's Windows, Apple's Mac OS, and
the free BSD OS. Linux Mint is also designed to work in conjunction with other operating systems
(including those listed above), and can automatically set up a “dual boot” or “multi-boot”
environment (where the user is prompted as to which operating system to start at each boot-up)
during its installation.

Linux Mint is a great operating system for individuals and for companies.

History

Linux Mint is a very modern operating system; Its development started in 2006. It is, however, built
upon very mature and proven software layers, including the Linux kernel, the GNU tools and the
Gnome desktop. It also relies on the Ubuntu and Debian projects and uses their systems as a base.

The Linux Mint project focuses on making the desktop more usable and more efficient for everyday
tasks performed by regular users. Underneath the desktop the operating system also provides a huge

collection of available software and a very well integrated set of services.

Linux Mint saw a rapid rise in popularity and more and more people use it every day.

Purpose

The purpose of Linux Mint is to provide a desktop operating system that home users and companies
can use at no cost and which is as efficient, easy to use, and elegant as possible.

One of the ambitions of the Linux Mint project is to become the best operating system available by
making it easy for people to get to use advanced technologies, rather than by simplifying them (and
thereby reducing their capabilities), or by copying the approaches taken by other developers.

The goal is to develop our own idea of the ideal desktop. We think that it is best to make the most

out of the modern technologies that exist under Linux and make it easy for everybody to use its
most advanced features.

Version numbers and codenames

Version numbers and codenames follow a unique logic in Linux Mint:

- Codenames provide a way to refer to versions of Linux Mint that is more familiar than using
a version number.



- Since version 5, Linux Mint has followed a 6 months release cycle and uses a simplified
version scheme. The version number simply gets incremented every 6 months.

- If revisions are made to a particular release (a bit like Service Packs in Windows) its
version number gets a minor revision increment. For instance “3” becomes “3.1”.

- Codenames in Linux Mint are always female names ending with “a”. They follow the
alphabetical order and the first letter of the codename corresponds to the index of the

version number in the alphabet.

So far Linux Mint has used the following codenames:

Version Codename
1.0 Ada

2.0 Barbara
2.1 Bea

2.2 Bianca
3.0 Cassandra
3.1 Celena
4.0 Daryna

5 Elyssa

6 Felicia

7 Gloria

8 Helena

9 Isadora

10 Julia

11 Katya

Editions

An Edition is a release of Linux Mint which is customized to address a certain set of needs. This
guide covers the Main Edition. Here are some of the most popular editions:
+  Main Edition (uses a Gnome desktop)

- KDE Edition (uses a KDE desktop)
- XFCE Edition (uses an XFCE desktop)

- LXDE Edition (uses an LXDE desktop, this guide is made about it)
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If you don’t know which edition to use, you should choose the Main Edition. LXDE and XFCE are
a right option for old computers, 'cause they save recurses of PC.

Note: If you intend to redistribute or to make commercial use of Linux Mint in the USA or in Japan and if
you’re not sure about patent legislation you should use the “CD No Codecs” installation images.

Where to find help

The Linux Mint community is very helpful and very active. If you have questions or a problem
related to Linux Mint, you should be able to get help from other users online.

First, make sure to register with the “Linux Mint Forums”. This is the very first place where you
can find help: http:/www.linuxmint.com/forum.

If you want to chat with other users you can connect to the IRC chat room. Under Linux Mint
simply launch “XChat” from the menu. If you’re using another operating system or another IRC
client make sure to connect to the “irc.spotchat.org” server and to join the channels “#linuxmint-
help” and “#linuxmint-chat”.

Linux Mint uses Ubuntu repositories (more on what this means later) and is fully compatible with it
so most of the resources, articles, tutorials, and software made for Ubuntu also work for Linux
Mint. If you can’t find help on a specific subject, make sure to search on the same subject for
Ubuntu.

Note: Ubuntu is another operating system based on GNU/Linux.

Note: A repository is an online service by which software is stored and made available for the
operating system to install and update from. Most operating systems based on GNU/Linux use
repositories and connect to them via HTTP or FTP to install and upgrade their software.

Installation of Linux Mint

You can download the Linux Mint operating system for free. It comes as an ISO file which you
need to burn to a blank DVD. The liveDVD is then bootable and provides a fully-functional
operating system which you can try without affecting your PC. In layman's terms, when you put
Linux Mint on a DVD and place it into your computer, you can try it out while leaving your current
system intact.

Note: It is also possible to write the ISO image to a USB stick or other memory device and boot from that, or to boot
from the ISO image on the hard drive, but these options are somewhat more advanced and the method presented here is
recommended. For help with alternative methods of installing and running Linux Mint, please visit the forums.

If you like what you see when running the liveDVD you can decide to install the system to your
hard drive. All the necessary tools (partitioning and installation tools) are present on the DVD.


http://www.linuxmint.com/forum

Download the ISO

Note: If you don't have a broadband connection, or if your Internet access is too slow you can order
the DVD from this web site: http://www.osdisc.com

Otherwise, you can visit the Linux Mint download page here:
http://www.linuxmint.com/download.php

Go to All Versions tab, choose Katya and look for LXDE (32-bit) button.

From this page, you should be able to find:

an MD5 signature
e a Release Notes link

e an Announcement link
e atorrent link
e alist of download mirrors

The file you need to download is an ISO file. There are two ways to download this file, by torrent (a
Peer to Peer protocol) or via a download mirror (HTTP or FTP protocol). Once your download is
finished, you can ensure your ISO file isn’t corrupted by checking its signature with the MD5.

Via Torrent

Torrent is a Peer to Peer (P2P) protocol. Basically, instead of downloading from a central location, a
torrent lets you download the ISO file in parts from different people across the Internet.

The more people who download the ISO file, the faster the download speed gets. This is the
preferred and recommended way to download Linux Mint.

Install a Torrent client
You need a piece of software called a “torrent client” in order to download files via torrent.

If you run Linux, you can install “Transmission”. If you run Linux Mint, Transmission is already
installed.

If you run Windows, you can use Vuze ( http://azureus.sourceforge.net/ ).

Download the Torrent file
The next step is to follow the torrent link from the Linux Mint website and to download the .torrent
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file. This file is very small. After it downloads, you should open it with your torrent client.

The torrent client will probably ask you where you want to save the ISO. Select a destination and
then wait for the download to complete.

For more information about the torrent protocol, visit: http://en.wikipedia.org/wiki/BitTorrent

Read the Release Notes

Your download is probably going to last at least an hour, so now would be the perfect time for you
to get familiar with the new features coming with the release you’re currently downloading.

The release notes are featured on the Linux Mint web page and answer the following questions:

* What are the new features delivered in this release?
*  What are the known problems of this release?
* How do I upgrade from the previous release?

They also contain screenshots of the latest release. Of course, you could find out about most
features highlighted in the release notes by simply using the operating system, but you might miss a
few things, so it is most reliable to read the release notes.

The release notes for Linux Mint 11 LXDE are available here:

http://linuxmint.com/rel katya Ixde.php

Check the MD5

You’ve read the release notes, you just can’t wait to play with the new features or try Linux Mint,
and your download just finished successfully. You’re ready to burn a DVD and to boot on it... but
hey! Wait for a second!

If that DVD is faulty you will experience weird bugs and will have a lot of trouble finding help. The
two most common reasons for a DVD to be faulty are:

* An issue with the download causing problems in your ISO file
* An error during the burn process that alters the contents of your burned liveDVD

The MD5 signature, which is present on the download page, provides a quick way for you to make
sure that your ISO file is exactly like it should be. So, let’s check the ISO file you just downloaded
before we burn it and save ourselves from a lot of potential problems.


http://en.wikipedia.org/wiki/BitTorrent

If you run any version of Linux you probably already have the md5sum program installed. Open a
terminal and “cd” to the directory where your ISO file is (for instance, if “linuxmint-gnome-
i386.is0” is on the Desktop), open a terminal and type:

cd ~/Desktop

md5sum linuxmint-l1l-lxde-cd-32bit.iso

This command should output a series of numbers and letters which comprise the MD5 sum, or
signature, of your ISO file. By design, any small change to the ISO file will cause this signature to
be significantly different, allowing us to verify that the file is exactly as it should be.

Compare that signature with the one on the download page of the Linux Mint website. If the two
signatures are the same, then you know your ISO file is exactly the same as the original and you can
now get ready to burn it on DVD

If you happen to run Windows, chances are you don’t have md5sum installed. You can get it from
here: http://www.etree.org/md5com.html

Place the ISO file and the md5sum.exe in the same place (let’s say in C:\) and run “cmd.exe”. In the
command line environment, type the following commands:

C:

cd \

md5sum linuxmint-1ll-lxde-cd-32bit.iso

Then compare the signature to the one present on the website.

Burn the ISO to DVD

Now that you have checked the ISO file with MD5, you are ready to burn it to a DVD.

Note: Linux Mint also provides images which fit on 700MB CDs. If you can't burn DVDs please use the CD images
instead.

Get a blank DVD-R (a DVD-RW should work as well, but this type of media is known to have
compatibility issues) and your favorite marker and label the DVD. Although labeling your DVDs
sounds trivial, you should be sure to do so, as you can easily end up with 20 unlabeled and
unidentifiable discs on your desk. :)

Insert the blank DVD-R in the drive and get ready to burn the ISO.
If you’re running Linux with Gnome right-click on the ISO file and select “Write to Disc”.

If you’re running Linux with KDE, launch K3B and in the “Tools” menu choose “Write ISO
Image”.


http://www.etree.org/md5com.html

In Ubuntu and other distros, you can use Brasero and choose Burn ISO image.

If you're running Linux and would like to use the terminal, from the directory you have downloaded
the image to:

| cdrecord -v -dao dev=1,0,0 linuxmint-11-lxde-cd-32bit.iso \

Replacing the numbers after dev= with the appropriate device number for your disc drive. You can
run

\ cdrecord -scanbus \

to find this out. You may need to be root to run these commands.

If you’re running Windows you can use a program like InfraRecorder:
http://infrarecorder.sourceforge.net/?page id=5

Note: Make sure to burn the ISO image to disk, and not to write the ISO file to the disk. A very common
mistake, especially for people using Nero, is to actually burn the ISO file on the disk as a data file. The ISO
file is an image of a disk so it needs to be burnt not as a file which will appear on the disk, but as an ISO
image which will be decompressed and whose content will be burnt onto the disc. After burning the DVD you
shouldn't see the ISO file within the disc, but rather folders like “casper” or “isolinux”. Most burning
software has a special option for this.

Boot the LiveDVD

Place the DVD in the drive and restart the computer. You should now see the following screen:

AT AT AL - AT O S e S

Note: If you don't see this screen and your PC boots as usual it’s probably because your BIOS is not set to boot on


http://infrarecorder.sourceforge.net/?page_id=5

DVD. Restart the computer and press F1, F2, Delete, or Escape (or whatever key lets you enter the BIOS
configuration) and change your BIOS settings to tell your computer to boot from its DVD

Install Linux Mint on your Hard Drive

From the first screen choose the default “Start Linux Mint” option and press Enter.

Leleops By Lipus plipe Ll Sz—iic

Start Linux Mint

Souet Ligues plipt Coopuet i DIty pode)
Cheel cthe iptegeliyg of tnz LU
ey e

Hort Freop loeal deise

Freazz Dlall] by sdit ogbinns

After a little while the live system should be ready and you should see the desktop:

Fel | # B ) @ ui) 12:12 27 ago 2011
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At this stage Linux Mint is not installed on your computer, it’s simply running from the DVD. The
system you have in front of you is, however, almost exactly the same as the one you will have on
your computer after the installation is finished.

Have fun with it and see if you like it. Bear in mind that when running from the DVD, Linux Mint
runs significantly slower than it does when it is installed on a hard drive, since it has to read data
from the DVD drive, which is a slower medium than the hard drive.

When you are ready, double-click on the “Install Linux Mint” icon located on the desktop. The
Installer appears:

- Install
Welcome
Catdra
Cestina ‘You may wish to read the release notes.
Cymraeg
Dansk
Deutsch
Eesti
Espafiol
Esperanto
Euskara
Francais
Gaeilge A
Galann r
Qui |ttt

If you haven’t read the release notes yet, and you have an Internet connection, then this an ideal
opportunity to review them; simply click on the underlined link. It is highly recommended that
users read the release notes prior to installation in order to advise themselves of new features, as
well as any issues that might affect their particular hardware configuration.

Select your language and press the “Forward” button.
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g Install

Preparing to install Linux Mint

For best results, please ensure that this computer:

@ has at least 2.6 GB available drive space
@ s plugged in to a power source

@ is connected to the Internet

Quit

Back

l Forward J

In the next screen, make sure you're connected to a power source (if you're using a laptop), the
Internet and that you have the recommended amount of disk space. Then press the “Forward”

button.

~ Install

Allocate drive space

What would you like to do?

o Install Linux Mint alongside them
o Erase disk and install Linux Mint
Yl

* Something else

Quit

This computer currently has multiple operating systems on it.

Back

Forward |

In the next screen you can assign your entire hard drive to Linux Mint or install it alongside other
operating systems. Alternatively, you can also define and assign the partitions manually.

If you choose to use the entire disk (Erase disk and install Linux Mint), its content will be
erased and Linux Mint will be installed as the only operating system on your computer.

If you choose to install it alongside other operating systems (Install Linux Mint alongside
them), the installer will use the free space available on other partitions to create a new one
for Linux Mint. You will be asked how much space you want to allocate to it. The installer
will then shrink a partition and take care of everything for you. Post-installation your
computer will have a boot screen from which you'll be able to boot all your operating

systems.

If you choose to specify partitions manually (Something else), a partition editor will appear,
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giving you full control over the partitioning of your hard drive. This is recommended only to
advanced users who understand how partitioning works under Linux. Note that Linux Mint
requires a partition of at least 3GB and that the recommended size for a swap partition is 1.5
times the amount of RAM available on the computer.

Choose the appropriate option and click on the “Forward” button.

- Install - %

Allocate drive space

Select drive: { SCSI3 (0,0,0) (sda) - 8.6 GB ATA VBOX HARDDISK v

The entire disk will be used:

©
Linux Mint

[devisda (extd)
8.6 GB

2 partitions will be deleted, use the advanced partitioning tool for more control

Use Entire Partition l I Use Entire Disk l

l Quit 1 [ Back 1 [ Install Now l

The next screen asks you to confirm. When ready press the “Install Now” button to start the
installation.

At this stage, the installation is going on in the background and the installer asks you setup
questions:

- Install -

Where are you?

Geonames.org

'New York| |

Back l Forward l

P Copying files...
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Choose your location on the map by clicking on the city which is the nearest to you. The purpose of
this step is to identify your time zone. Make sure the “Current time” appears correctly and click the
“Forward” button.

Note: Sometimes the installer doesn't properly handle Summer/Winter time adjustments, so even by selecting
the proper city you might see a difference of an hour or so with the correct time. Simply ignore this at this
stage and remember to make sure that the time is correct after you reboot in your newly installed Linux Mint
desktop.

> Install

Keyboard layout

Choose your keyboard layout:

Tanzania

Thailand USA - Alternative international (former us_intl)
Turkey USA - Cherokee
Turkmenistan USA - Classic Dvorak
USA - Colemak
Ukraine USA - Dvorak
United Kingdom USA - Dvorak international
Uzbekistan USA - Group toggle on multiply/divide key
Vietnam “| |USA - International (AltGr dead keys)

Figure Out Keyboard Layout |

Back [ Forward ]

P Copying files...

Select your keyboard layout. If you are not sure about exactly which layout matches the keyboard
you have, click on the text field at the bottom of the screen and start typing with your keyboard.
Make sure the keys you press match the characters that appear in the text field in order to ensure
you have selected the right keyboard layout. Some layouts only differ with respect to accents,
numbers and punctuation signs, so make sure to test these as well.

When you’re ready click the “Forward” button.

Enter your real name and a user name and password. Every time you’ll use Linux Mint you’ll use
your account with this user name and password. Once Linux Mint is installed you’ll be able to
define other accounts if other people are to use this computer.

Also give your computer a name. This name will be used by your computer on the network or in
various places of the system. If you’ve never really thought about naming your computers, then
now is the time. People commonly pick flower (dahlia, rose, tulip) or planet (mars, jupiter, pluto)
names for the computers on their network. It’s entirely up to you what you want to use, but make
sure to pick a name you like and that you will easily remember.

14



Note: Capital letters, spaces and special characters are not permitted in the username or in the name of the computer.

If you're the only one using the computer and you want to bypass the login screen, check the option “Log in
automatically”.

When you’re ready click on the “Forward” button.

> Install

Who are you?

Your name: [Joe | (]
Your computer's name: rkat;.ra | @
The name it uses when it talks to other computers.
Pick a username: |joe | @
Choose a password: | sessessese | strong password
Confirm your password: ©00000000e (]

"] Log in automatically
|D| Require my password to log in

"] Encrypt my home folder

Back Forward

P Copying files...

The installer might detect other operating systems on your computer and ask you if you want to
migrate some personal information. Typically this allows you to migrate bookmarks, contacts,
favorites and other sorts of personal information from other operating systems installed on your
hard disk drive into the newly installed Linux Mint.

When you’re ready click on the “Forward” button.
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- Install -

Welcome to Linux Mint

Welcome and thank you for choosing
Linux Mint. This slideshow will show you
around while the system is being
installed on your computer.

P Copying files...

The installation should take between 10 and 15 minutes.

Note: The installer will download packages from the Internet to support the language you’ve selected. Your
computer needs to be connected to the Internet for this to work. Otherwise just “skip” that step and you’ll be
able to add support for your language after the installation is finished and you’ve rebooted into your new
system.

Once the installation is done click the “Restart Now” button and the liveDVD environment will shut
down.

When prompted, remove the DVD from the drive and press Enter.

Your PC is now ready to boot Linux Mint from the hard drive.

The Boot sequence

Upon reboot, if you have more than one operating system installed, you should see a “boot menu”.

Once Linux Mint is finished loading you should see a new screen inviting you to enter your
username and password. This screen is the “Gnome Login Manager” and is commonly called
“GDM”. Enter the password you chose during the installation.

16



Note: By default, your “root” password is the same as the password you chose during the installation. If you do not
know what this means, then don't worry about it.
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Introduction to the Linux Mint LXDE Desktop

This section of the guide will focus on the technologies and the tools that are specific to Linux Mint
LXDE desktop and provide information on some of the applications and technologies included by
default in the LXDE Edition.

The LXDE Desktop

The “desktop” is the component of the operating system which is responsible for the elements that
appear on the desktop: The Panel, the Wallpaper, the Control Center, the menus...etc.

The LXDE Edition of Linux Mint uses the “LXDE” desktop which is both intuitive and powerful,
and lighter than others are.

From Wikipedia: LXDE is a free and open source lightweight desktop environment for Unix and
other POSIX compliant platforms, such as Linux or BSD. The name LXDE stands for "Lightweight
X11 Desktop Environment".[1][2]

LXDE is designed to work well with computers on the low-end of the performance spectrum such
as older resource-constrained machines, new generation netbooks, and other small computers,
especially those with low amounts of RAM.[3].

Full information: http://en.wikipedia.org/wiki/L. XDE

Panel preferences

The Panel is the place at bottom of desktop where you can find date & time, volume control,
network indicator, battery indicator, Applications Menu and so on.

If you'd like to change its looking, or instead on bottom place it top position or so more, just right
click on bottom panel and choose Panel Preferences.

Getting to know the menu

The LinuxMint LXDE Menu comes with a unique menu where you can find all the installed
software.

To open the menu click on the “circle shape” button at the bottom-left corner of your screen.

You'll see a screen-shot like next.

18


http://en.wikipedia.org/wiki/LXDE
http://en.wikipedia.org/wiki/LXDE#cite_note-2
http://en.wikipedia.org/wiki/Random_access_memory
http://en.wikipedia.org/wiki/Netbook
http://en.wikipedia.org/wiki/LXDE#cite_note-About-1
http://en.wikipedia.org/wiki/LXDE#cite_note-Licensing-0
http://en.wikipedia.org/wiki/BSD
http://en.wikipedia.org/wiki/Linux
http://en.wikipedia.org/wiki/POSIX
http://en.wikipedia.org/wiki/Unix
http://en.wikipedia.org/wiki/Desktop_environment
http://en.wikipedia.org/wiki/Free_and_open_source_software

] Accessories

I® Graphics -
H Internet E
[ office "
Bl sound & video .
B system Tools "
Preferences "
< Software Manager

B Terminal

£ Run

G Logout

e
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- Run. For running any application, if you know the right command.

. Terminal.

i Terminal
File Edit View 5Search Jerminal Help

/ Don't look back, the lemmings are \
\ gaining on you. /

The “Terminal” button launches an application called “Terminal” which lets you enter commands
directly using the keyboard. If you’re used to Microsoft Windows you may think that this is old hat,
because in Windows the command line hasn't progressed much further than the “DOS prompt” and
is hidden away in an accessories menu. One of the ways in which Linux systems differ from
Windows systems is that the terminal is quite important in Linux, as it is often used as a way of
getting more direct control over one's computer. We’d probably agree that the Terminal isn’t the
most visually appealing application included in Linux Mint, but it is worth knowing that it is by far
the most powerful, and once learned it’s actually not very hard to use.

In fact, it is worthwhile understanding that every command that you execute using a graphical
desktop environment goes through the Terminal. When you click on an icon on the menu, for
example, you are instructing Gnome to pass a textual instruction to the Terminal. As an instructional
exercise, if you open “Main Menu” from the “Look and Feel” section of “Control Center” (see
above), and navigate to any of the application menus, pick an application, and click on the
properties button, you will see in the “Command” field the text command that is passed to the
system when you click on that application's entry in the menu. In other words, you have already
been using the Terminal for some time, perhaps without realizing it. All that was different was that,
instead of you typing out the commands, your desktop (Gnome) was doing it for you (which is a
good thing because nobody wants to remember hundreds of application names all the time).

Sooner or later, though, you will probably have be in a situation which causes you to use the
Terminal directly, either to access commands that are not available through any GUI, or to get a job
done more efficiently. Yes, you read that right! It can be more efficient to type a single command,
for certain tasks, than to open up lots of windows to achieve the same thing. The more you use it,
the more you’ll come to actually like it. Remember how you didn’t like certain things when you
were a kid and how you couldn’t do without them now? Terminal is one of these things. In a few
weeks, you’ll be completely addicted to it. You'll begin to feel in complete control of your
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computer. There will be times when you won’t even have to use the Terminal, but you will anyway,
because for some tasks it’s faster, more accurate, more versatile and actually simpler to use than
equivalent graphical interfaces. And anyone watching you will think you're a complete pro.

- Software Manager.

The “Software Manager” button launches the Linux Mint Software Manager. This program is the
recommended way to install software in Linux Mint. We will talk more about this feature later on;
for now, let's explore the other options.

> Software Manager
File Edit View Help

Categories =X |

Software Manager

Please choose a category

Featured All Packages Internet Sound and Graphics Office
35 packages 33584 packages 3137 packages video 609 packages 307 packages
96 packages

. rZzr
@' \ J & s %)
Games Accessories System tools Fonts Science and  Programming

1183 packages 1584 packages 1139 packages 90 packages Education 1892 packages
1030 packages

33584 packages are currently available

| £ 0 ongoing actions

. Preferences

In this menu you'll be able to adjust your desktop as you like: customize look and feel, Desktop
session settings, Keyboard and mouse, LxKeymap (this is very useful if your keyboard doesn't work
properly in a new installation), Passwords, Power management, Preferred applications, Screensaver
and so on.

- System Tools
In this menu you'll be able to configure your system. You should be able to: configure Users and

groups, update system, configure software sources, shared folders, add printers, language support,
Firewall configuration, Disk utility, Back-Up tool and so on.
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. Software included

Since one of the purposes of Linux Mint is to be easy to use and to work out of the box, a collection
of software is included by default in order to let you achieve common/ important tasks.

The 5 categories, after System Tools menu, provide most of the applications you’ll use on a daily
basis. As you install new software, new categories might appear.

In “Sound & Video” you can find the following software:

Name Description

Xburn A CD/DVD burning application. Xburn can also make
audio CDs from multimedia files.

VLC Media Player A multimedia application which is associated with most

video and audio files (alternative to Microsoft Media
Player). Supports a lot of multimedia codecs.

GNOME Player A video player.
GNOME Alsa Mixer A sound mixer.
Exaile Music manager and player. It incorporates automatic

fetching of album art, lyrics fetching, Last.fm scrobbling,
support for many portable media players, internet radio
such as shoutcast, and tabbed playlists.

In “Office” you can find the following software:

Name Description

AbiWord A word processor (alternative to Microsoft Word and
compatible with DOC.)

Gnumeric The Gnumeric spreadsheet is part of the GNOME
desktop environment: a project to create a free, user
friendly desktop environment.

In “Internet” you can find the following software:

Name Description

Dropbox The easiest way to share & store files online.
Http://dropbox.com

Firefox A Web browser

Pidgin An Internet Messenger (compatible with AIM, Bonjour,

Gadu-Gadu, Google-Talk, GroupWise, ICQ, IRC, MSN,
MySpacelM, QQ, SIMPLE, Sametime, XMPP, Yahoo and

Zephyr)
Sun Java 6
Thunderbird An Email application
Transmission A Torrent client.
Xchat IRC An IRC chat program. It is configured by default to

automatically connect you to the Linux Mint chat room
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| (very useful if you want to talk to other Linux Mint users). |

In “Graphics” you can find the following software:

Name Description

GIMP Image Editor An application that lets you modify, convert or even create
pictures. The best Linux equivalent to Photoshop.

Simple Scan A tool to capture images from a scanner

In “Accessories”, you can find the following software:

Name Description

Catfish File searching tool

Character Map A tool to easily copy and paste special characters (accentuation
for instance)

File Manager PCMan FM file manager

Calculator A calculator

gEdit A text editor called “gedit”

Image Viewer

LXTerminal The Terminal

Screenshot A tool to take screenshots. You can also launch this with the
“Print Scrn” key on your keyboard to take screenshots of the
desktop, or with “ALT”+”Print Scrn” to take screenshots of the
current window.

Xfburn Burning tool CD for data and audio composition and so on.

Make your own shortcuts

If you like the idea of having a shortcut for any application, you can simply right-click at the
application from the menu and click on Add to desktop to place it on your desktop.

Launch applications automatically when you log in

Go to Menu — Preferences — Desktop Session Settings, then you'll can enable or dissable some
applications on start-up. The application will then be launched automatically each time after you log
in.

Change the appearance of the panel

You can customize the panel in many ways. Right click on “Menu” and select “Panel Settings”.
Now you can change the panel from bottom to top, change appearance, size and a few more.

23



Software Management

Package Management in Linux Mint

If you have installed Linux for the first time, then you may not be familiar with the concept of
organizing software into “packages”. You will soon become familiar with package management and
appreciate the advantages it offers in terms of security, control and ease of use.

We have tried to make it so that all or most of your hardware was detected and drivers were
installed automatically so that your computer would work out of the box. We have also tried to
make it so that you could do many of the things you want to without having to look around for third
party software on websites. You may have noticed that your Linux Mint installation already has a
full office suite, a professional-quality image-editing solution, an IM and an IRC client, a disk
burner, and several media players (as well as many other basic accessories). Relax, it's okay! You
haven't stolen anything! This is what free software is all about! And the truly great thing about
package management in Linux Mint and generally is that you should never need to look far and
wide for extra software, even when the time comes that you do want more functionality from your
Linux Mint system.

This section is intended to explain how this works and the advantages that it can bring to you. It's a
bit long, but hopefully it will provide you with a good understanding of the philosophy behind
package management and why it is considered a Good Thing (a phrase commonly capitalized by
Linux users to mean that something is squarely in the category of good). If you're in a hurry, you
can skip to the next section which will tell you how to actually use the package system.

The problems with browsing software vendors' websites and downloading and installing the
software they offer are many:

It is difficult or impossible to find out if the software has been tested to work with your

operating system

It is difficult or impossible to know how this software will interact with the other software

installed on your system

It is difficult or impossible to know if you can place your trust that software from an

unknown developer software will not cause any harm, willful or negligent, to your system

Even if you know about a specific piece of software and its developer, you cannot be entirely

sure that you are not downloading an executable that has been swapped out by a malicious

third party for some type of malware.
Furthermore, a problem with downloading and installing multiple different programs, from multiple
different developers, is that there is no managerial infrastructure. Before you say “big deal”,
consider how you are going to keep all these different pieces of software up to date. If you get tired
of a program and want to remove it, how do you know how to achieve that? The program in
question might not have come with a removal option, and even if it did, much of the time this will
fail to remove the software cleanly and completely. In a very real sense, when you ran that installer
program, you gave up some of your control of your computer to a program written entirely by a
complete stranger.
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Finally, software which is distributed in this way is often, by virtue of necessity, “static”. This
means that not only do you need to download the program itself, but also all of the data libraries
that are required for it to run. Since a third-party software developer cannot know which data
libraries you may already have available on your system, the only way that they can guarantee it
will run on your system is by supplying all of the data libraries it needs along with the program
itself. This means bigger downloads, and it means that when the time comes to update a given
library, it needs to be done separately for all those programs using it, instead of just once. In
summary, the distribution of static software results in the unnecessary duplication of a lot of work.

Package management in Linux Mint, and GNU/Linux operating systems in general, has been
established for some time and is the preferred method for managing software as it avoids all of
these issues. We've been safely and automatically installing our software since the early 1990s.

Software is first written by a developer, as you might expect, and this end of the production chain is
known as “upstream”. As a user of a Linux distribution, you are referred to as being at the furthest
point “downstream” (unless you're an admin, in which case your users are the furthest point
downstream, but you knew that because you're an admin). Once the developer is happy with the
program or the update to the program they have written, they will release the source code for it.
They will also communicate in their documentation which data libraries or other programs they
took advantage of when they were writing the program. They have been doing this for some time
and there are standardized and venerable ways for them to do this. Note that, with a few exceptions
(usually either hardware manufacturers who release drivers for Linux, like nVidia or ATI, or certain
major companies like Adobe, who we can trust) they release the actual source code for the program,
that is, the list of instructions in that program in a human readable form. This has a number of
implications, but most importantly for this discussion it means that they are willing to have their
software peer reviewed by anyone and everyone with an Internet connection. It's awfully difficult to
sneak spyware into your program when you're letting everyone see what you've written!

The software now moves down the stream to package maintainers, who are either volunteers or paid
employees working for a Linux distribution. It is their responsibility to compile the source code for
the software, test it on the distribution to make sure that it works, resolve any problems that they
encounter and finally package the compiled (i.e., machine-readable) software in a convenient
format. This package contains the executable program(s), their configuration files, and the
instructions the package management software needs to successfully install it. Note that it won't
ordinarily contain any static libraries, since it doesn't need to — the libraries are provided by other
packages, and are therefore known as shared libraries. Your package management software will
know if that a particular package requires another package to be installed first (like a shared
library), because, as you will remember, the data libraries and related packages needed for the
software to work were declared further upstream and that information is included in the package.
The instructions are sufficiently detailed that even specific versions of other packages can be
requested to ensure interoperability. The finished package is then uploaded to a special file server,
which is called a software repository.

It is from that single location that you are able to download and install the software you need. You
will know that the location is bona fide, because it is signed with a certificate that your package
manager will check. You will also know that each individual package that you install is secure,
because each package is itself signed by a GPG key, which your package manager will also check.
Your package manager will even run an MD5 sum on each package to make sure that nothing went
wrong when it was downloading, just like we did before with the LiveDVD iso. Notice how it's
doing all of this for you. You're just sitting back, sipping a martini, and chatting in #linuxmint on
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xchat. The package manager has downloaded the packages you have selected, it will follow, to the
letter (computers are fastidious in following instructions), the instructions in the package to
perfectly install your software, and all of its dependencies, in the right order. There is no space for
human error — if the package worked on the maintainer's computer, then it ought to on yours
because the package manager will follow exactly the same procedure.

When it comes time to check for software updates, your package manager will automatically
compare the software version that you have against what is available in the repository, and do all the
necessary work to keep your system running smoothly and securely. So, if version 2.4 of BestSoft is
uploaded to the repository, and you have version 2.3, the package manager will compare those
version numbers, and offer to install the latest version, taking care, of course, of all the
dependencies for the newer version of the software.

Sounding good yet? It gets better.

Humans err where computers don't and from time to time something may go wrong in this process.
Perhaps you will, by accident, install hardware drivers for the wrong piece of hardware and this
might break something. We've all done that. Or perhaps there's a bug or your favorite feature was
removed by the program's developer for some reason. These problems demonstrate, paradoxically,
the strength and security of package management. Because your package manager keeps fastidious
records of everything it ever does, it is able to reverse installations, cleanly and completely. It will
make sure that removing one package doesn't break any others, and you can even tell it specifically
to do things like not automatically upgrade certain packages, because you like them the way they
are, or to revert to an earlier version. Finally, the whole process is very heavily peer-reviewed.
Because you are part of a large community of Linux users, all using the same repositories to obtain
their software, if anything goes wrong you can be absolutely sure there will be a big fuss about it,
and that the problem will be resolved quickly! In this way, software distribution in GNU/Linux
distributions is very much based on trust, from the moment the original developer displays their
source code for all to see, to the open discussion on the distribution's website. You can be confident
in the software you obtain, not only because of the security protocols already mentioned, but
because if anything does go wrong everyone will be talking about it!

Let's look again at our list of problems and see what we have solved:

It is difficult or impossible to find out if the software has been tested to work with your
operating system
o You know that the software available to you through the repository has been thoroughly
tested by the package maintainer and the testing team to work with your operating
system. They won't want to get it wrong, mostly on principle, but also because if they do
they'll soon be getting lots of emails.
- It is difficult or impossible to know how this software will interact with the other software
installed on your system
o Similarly, package maintainers try their utmost to ensure that packages won't conflict
with other packages offered by their distribution. Of course, they might not have every
last package installed on their testing machines (in fact, usually package maintainers
build their packages on clean installations to ensure that they are standard), but if a
member of the user community finds out that there is a problem, they will no doubt let
the distribution team know, and the problem will be fixed, or at least worked on. Unless
you are a beta tester, then you are unlikely to ever see such a conflict, because that's
what beta testing is for.
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- It is difficult or impossible to know if you can place your trust in the developer that their
software will not cause any harm, willful or negligent, to your system
o Package maintainers are hardly likely to package software they know will harm people's
computers (including their own)! Only software which is known and trusted will ever
make it to the repository.

- Even if you know about a specific piece of software and its developer, you cannot be entirely
sure that you are not downloading an executable that has been swapped out by a malicious
third party for some type of malware.

o In addition to the usual security measures put in place by the institutions who own the
servers (usually prestigious academic or research institutions, or large companies), the
repository and packages themselves are secured by certificates and GPG keys. If
something's gone wrong, your package manager will tell you about it. The present
author, in ten years of using Linux, has never once known anything to go wrong in this
respect.

« Itis difficult to remove (all traces of) installed programs
o Because the package management software keeps a complete record of all of its actions,

it is quite capable of reversing any steps that it took in the past, while ensuring that
removing one package will not cause any other package to fail.

- Static packages are big and clunky
o Because you're using package management, you will only ever download static libraries

when there is no shared alternative. If you need new shared data libraries to install a
given program, your package manager will know this and install them for you
automatically. You will only ever have to download a shared library once because, well,
it's shared by all the programs that need it. If you end up removing the last package that
needs a shared library, then the package management software will remove that too. But,
if you decide that you do want to keep the shared object anyway, perhaps because you
just know you'll need it later, then you can tell the package management software to do
that, too.

- I'mstill not convinced
o Good! Post a message on the forums about it if you have a genuine concern about

package management, or to ask about other people's experiences. It bears repeating that
the package method of distribution in GNU/Linux relies on trust, so if there's a problem,
we want to hear about it!

A final word. You may have been subjected to rumors to the effect that Linux isn't finished yet, or
that if you use Linux then you are a beta-tester, or that Linux software is unstable. These are all half
truths. “Linux” will never be “finished”, any more than any other major operating system can be
considered “finished”. From the Linux kernel to the artwork on your screen, all the elements of your
operating system will always be under some kind of development. This is because programmers are
working hard to keep us up to date with the latest developments in programming and hardware
technology. This does not mean that the software available for you to use is of bad quality. The base
system at the core of Linux Mint has been under heavy development for about two decades now,
and is very mature, stable, and proven. While there are definitely unstable versions of most of the
software on your operating system, you won't be using them because you're not a beta tester. You
know you're not a beta tester, because you're reading this. The software available to you on the
repositories you use will always be stable and well tested, unless you change those repositories to
the ones used by the testers (in which case congratulations, you've just become a tester). It's a bit of
a no-brainer, really.
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So, to summarize with an example, when you install Opera, Real Player or Google Earth in Linux
Mint, these applications do not come from their original developers (Opera, Real and Google). Of
course the upstream application comes from these developers, but only after they’ve been properly
packaged and tested do they become available for you. So, in other words, you should never need to
go and browse the Internet to look for software, as everything you need is available and already
tested for you and for your system by the Linux Mint and Ubuntu teams. All you need to do is
choose what you want to do.

Linux Mint will update itself automatically through a tool called the Update Manager, which will
update not only the base operating system, but all the software installed on your machine as well.

It's that simple. Whew!
Some of the most popular applications that are not installed by default in Linux Mint are Opera,

Skype, Acrobat Reader, Google Earth and Real Player. You might also want to add games (a lot of
nice free games are available for Linux... try installing gnome-games to start out with).

The Software Manager

The easiest way to install software in Linux Mint is to use the Software Manager. It is built on top
of the package technology we discussed earlier, but makes things easier to understand, as it allows
you to install programs rather than packages (though, remember, it is still using the package system
in the background, so it still has the same benefits).

Open the menu and select “System tools - Software Manager”.

The Software Manager lets you browse the software made available for Linux Mint. You can
browse by category, search by keyword or sort the software by rating and popularity.

Synaptic & APT

If you want to install more than one application or if you’re looking for something which is not in
the Software Portal or in the Software Manager, Linux Mint provides two other ways to install
software. One is a graphical tool called “Synaptic” and the other is a command line tool called
‘(APTJ’.

Let’s see how we can install Opera (an alternative to the Firefox Web Browser) with these tools
instead:

SYNAPTIC. Open the menu and select “System Tools — Synaptic Package Manager”.
Click on the “Search” button and type “opera”. Then go through the list of packages and find the

one corresponding to the Opera Web Browser. Tick the box and select “Mark for Installation” then
click on the “Apply” button.
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APT. Now let’s see how we could have installed Opera using the APT command line tool.

Open the menu and select “Accessories - LXTerminal”. Then type the following command:

‘apt install opera

Note: Make sure synaptic is closed before using APT. Synaptic is using APT in the background so both can’t run at the
same time. The same goes for the Software Manager.

As you can see APT is extremely easy to use but it’s not graphical. It’s OK. If you’re starting with
Linux you probably prefer to deal with a graphical interface (that's why they're there) but as time
goes on you’ll prefer things to be fast and efficient and as you can see the fastest way to install
Opera is to type “apt install opera”. It can’t be simpler than that.

There is one important difference between the Software Manager and Synaptic/APT though. With
Synaptic and APT you basically deal with packages. In our example the Opera application was very
simple and was only made of one package which name was also “opera”, but this will not always be
the case, and sometimes you might not know what the name of the package is. Sometimes you
might not even have access to the packages for a particular application.

The Software Manager is different because it lets you install “applications” by getting the right
“packages” for you, not only from the repositories (packages databases) that Synaptic and APT
have access to, but also from other places on the Internet.

So you might use the Software Manager for two different reasons:

- Because you’re not used to APT/Synaptic
- Because it can actually install applications you don’t have access to using other tools.

Remove applications

Using APT

Another way to remove applications is by using APT. Again, we’re talking command-line utility
here, but see how surprisingly easy this is:

Open the menu and select “Terminal”. Then type the following command:

‘apt remove opera

Note: Make sure synaptic is closed before using APT. Synaptic is using APT in the background so both can’t run at the
same time.

And that’s it. With one single command you’ve removed Opera from your computer.

Synaptic

You can also use Synaptic to remove packages... Linux is all about choice so let’s see how to do
this.
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Open the menu and select “Package Manager”.

Click on the “Search” button and select “opera”. Then go through the list of packages and find the
one corresponding to the Opera Web Browser. Tick the box and select “Mark for Removal” then
click on the “Apply” button.

Update your system and your applications

If a new version of any package installed on your computer is made available you can upgrade to it.
It may be a security update for some component of the operating system, it may be an optimization
in one specific library or it may even be a newer version of Firefox. Basically, your system is made
of packages and any part of it can be updated by updating some of those packages. This means
replacing the current package with a newer version.

There are many ways to do this but only one of them is recommended.

You could use APT to upgrade all your packages with one simple command (“apt upgrade”) but we
strongly recommend you don’t do so. The reason is that it doesn't make any distinctions in selecting
which updates to apply and assumes that you want all of them.

Some parts of the system are safe to update and some others aren’t. For instance, by updating your
kernel (the part which is responsible among other things for hardware recognition) you might break
your sound support, your wireless card support or even some applications (such as VMWare and
Virtualbox) which are closely linked to the kernel.

Using the Update Manager

Linux Mint comes with a tool called the Update Manager. It gives more information about updates
and lets you define how safe an update must be before you want to apply it. It looks like a shield
and sits on the bottom-right corner of your screen.

If you place your mouse pointer on top of it, it will tell you either that your system is up to date or,
if it isn't, how many updates are available.
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v Update Manager
File Edit View Help

<a B '3 +
Clear SelectAll Refresh Install Updates
Level ¥ | Upgrade Package New version Old version

1 B mintwelcome 1.4.0 1.3.9
1 B mintsystem 7.78 7.7.6
1 B mint-artwork-gnome 2.6.11 2.6.10
1 |E]
1 ] mint-search-addon 2011.05.01 2011.04.29
2 =] thunderbird 3.1.10+build1+nobinonly- 3.1.9+nobinonly-0ubunt
2 |3 firefox-gnome-support 4.0.1+build1+nobinonly-0 4.0+nobinonly-0ubuntu]
2 1= firefox-globalmenu 4.0.1+build1+nobinonly-0 4.0+nobinonly-0ubuntul

Description | Changelog

One of the most advanced menus under Linux. MintMenu supports filtering, Favorites, easy-
uninstallation, autosession, and many other Features.

110 recommended updates available (126MB)

If you click on the lock icon, the Update Manager opens and shows you the updates that are
available. The interface is very easy to use. For each package update you can read the description,
the changelog (this is where developers explain their changes when they modify the package), and
eventually if Linux Mint assigned warnings or extra information about the updates. You can also see
which version is currently installed on your computer and which version is available for you to
update to. Finally, you can see the stability level assigned to the package update. Each package
update brings improvements or fixes security issues but that doesn’t mean they’re risk-free and
can’t introduce new bugs. The stability level is assigned to each package by Linux Mint and gives
you an indication of how safe it is for you to apply an update.

Of course you can click on the columns to sort by stability level, status, package name or by
version. You can select all updates or unselect all of them by using the “Clear” and “Select All”
buttons.

Level 1 and Level 2 updates are risk-free and you should always apply them. Level 3 updates
“should be safe” but, although we recommend you take them, make sure you look over them on the
list of updates. If you experience a problem with a particular Level 3 update, tell the Linux Mint
development team so they can take measures to make that update a Level 4 or a Level 5 so as to
warn or even discourage others against applying it.
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[ - Preferences - Update Manager

Levels | Auto-Refresh | Update Method | Ignored packages | Icons

Level Description Tested? Origin Safe? Visible?
Certified packages. Tested through Romeo ; :
1 or directly maintained by Linux Mint. ] Linux Mint  [&5]  [£]
2  Recommended packages. Tested and approved by Linux Mint. @& Upstream [ (&
3 safe packages. Not tested but believed to be safe. [x] Upstream [&3]  [&4]
Unsafe packages. Could potentially affect —
4 the stability of the system. ) ik
= Dangerous packages. Known to affect the stability = o
5§ of the systems depending on certain specs or [} Upstream
hardware.
| Cancel | | Apply |

If you click on the “Preferences” button you should see the screen above. By default the Update
Manager tells you about Level 1, 2 and 3 updates. You can decide to make Level 4 and 5 “visible”.
This will make more updates appear in the list. If you want to you can even make Level 4 and 5
updates “safe” (although this is not recommended). This will cause them to be selected by default
within the Update Manager.

The Update Manager only counts “safe” updates. So when it tells you your system is up to date, it
means there are no updates available assigned with a level that you defined as being “safe”.

The Update Manager only shows “visible” updates in the list.

For example, if you made all levels “visible” and only Level 1 and 2 “safe”, you would see a lot of
updates in the list, but the Update Manager would probably tell you that your system was up to date.

The “Auto-Refresh” tab allows you to define how often the Update Manager checks for updates.
The “Update Method” tab lets you define how the Update Manager checks for new updates.

The “Startup delay” is the amount of time the Update Manager waits before checking for an Internet
connection. This delay is used to give the Network Manager an opportunity to establish a

connection when the computer starts.

You can also define which domain name is used by the Update Manager to check the connection to
the Internet. The Update Manager will try to ping this domain before looking for updates.

The “Include dist-upgrade packages” option allows you to define whether the Update Manager
should install new dependencies or not. For instance if package A version 1 was installed on your
computer and package A version 2 became available, but version 2 had a new dependency on
package B which isn’t installed on your computer... what would happen?

If you left this checkbox unchecked, version 2 would not appear as an update in the list of updates.

If you checked this checkbox, it would, and if selected it would install packageB as a dependency.

Be careful with this option as dependency can install new packages on your behalf but they can also
sometimes remove packages you already have installed.
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In the “Ignored packages” tab you can define packages for which you do not want to receive
updates. “?” and “*” wildcard characters are supported.

The “Proxy” tab lets you define proxy settings.
The last tab lets you change the icons used by the Update Manager in the system tray.
If you get errors with the Update Manager (“Can’t refresh list of packages” for instance), you can

check the logs. Right click on the lock icon in the system tray and select “Information”. The
following screen appears:

r Information - Update Manager
Information

Permissions: root

Process|D: 19509

Log file: Jtmp/mintUpdate/GDKkDa

Log File

++ Launching mintUpdate in root mode

++ Starting refresh

++ Auto-refresh timer is going to sleep for 15 minutes, 0 hours and 0 days
++ Found 110 recommended software updates

++ Refresh finished|

Close

In this screen you can see the process ID of the Update Manager, whether it's running with user or
root permissions, and the content of its log file.

You can also review the updates that were applied on your system (provided they were applied via
the Update Manager) by clicking on “View->History of Updates™.

Tips and Tricks

Are you making the most of your desktop? Do you usually press “CTRL+C” on your keyboard to
copy some text? Do you open a text editor to take a quick note? How do you share files with your
friends? There are many ways to perform simple tasks, some more efficient than others. This
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chapter is going to show you a few particularities of Linux, Gnome, and the Linux Mint desktop, to
make sure you make the most of your system.

Copy and paste with the mouse

Most people are used to clicking on the “Edit” menu or to right clicking on the content they want to
copy. In Linux Mint you can do this as well, but most GNU/Linux operating systems also let you
copy and paste content from the comfort of your mouse. Here's how it works: The left button of the
mouse copies and the middle button pastes. It's as simple as that!

Let's give it a try. Launch LibreOffice Writer or a text editor, or any application of your choice that
lets you input text. Now type a few sentences. Select some of the text you just typed with the left
button of your mouse. Think you need to click on the “Edit” menu and press “Copy”? No? Bet
you're thinking you would use a combination of keys on your keyboard such as “CTRL+C”. In
Linux, it is much simpler. Just by selecting the text, you've already copied it. That's right... that text
is now copied to your “mouse buffer” and you don't need to press anything else.

Now click on some other part of the document to move the cursor there and click the middle button
of your mouse (or the wheel-click if you have a mouse with a wheel, or both the left and right
buttons together if your mouse only has two buttons... everything's been thought of, apart from
those weird Mac mice with only one button). As you can see the text you previously selected has
now been pasted.

The more you get used to this the faster you'll get at copying and pasting content. This technique
also works on most Unix and GNU/Linux operating systems.

Note: The buffer used by the mouse is not the same as the one used by the Gnome desktop. So you can actually copy
something with your mouse and copy something else with “CTRL+C” or with the “Edit” menu. Thanks to this you can
copy two elements at a time and depending on how you copied them you can paste them with either the middle mouse
button or with “CTRL+V” or the “Edit” menu.

Archive emails and websites as PDF

Do you bookmark web pages when you want to read them later? Do you keep old emails in your
inbox when they contain some information you might need to remember? Are your inbox and your
bookmarks cluttered with things you don't need but don't want to risk loosing? Shouldn't you store
this kind of information somewhere else? Of course you could use Tomboy Notes for this but
pasting an entire article from the Web to a note is not exactly ideal, you'd loose the pictures, the
layout and a lot of information. Why not just print the content instead? Not on paper, but as a PDF
file...

Linux Mint comes with a PDF printer installed by default. This printer takes the output of the
application you're using and sends its content to be stored within a PDF file. So, for instance, if
you've just booked a flight on the Web and you were given a flight reference sheet and a registration
ID, just hit the file menu and select print.
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Choose the “Print_to_PDEF” printer and click on the “Print” button.
The page you were looking at will be printed within a PDF document stored in your Home folder.

Similarly you can print emails from Thunderbird or any kind of content from any application and
have the content stored in a generated PDF file within your Home folder.

Conclusion

There's a lot more to learn about Linux Mint and about Linux in general. This guide was just an
overview of some of the aspects related to your desktop. By now you should feel more comfortable
with using it and you should have a better understanding of some of its components. Where are you
going to go next? Will you learn how to use the terminal? Will you give other desktops a try (KDE,
XFCE, etc.)? It's entirely up to you. Remember, Linux is about fun and the community is there to
help. Take your time and learn a little bit every day. There's always something new no matter how
much you know already.

Enjoy Linux and thank you for choosing Linux Mint.
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